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i. Package Contents

Upon unpacking your empeg car player, please check that each of the following items are enclosed:

*  empeg car player

e Car mounting cage

* Infra red remote control

¢ Home power supply

e Power supply mains cable for your locality
¢ emplode software CD

e USB connection cable

*  Serial connection cable

*  Power line suppressor

*  Amplifier grounding cables (pair)
e Car bumper and window stickers

If any of the items are missing, please contact your supplier.

ii. Official Certifications

FCC Certification

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part |15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

*  Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and the receiver.

¢ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

Shielded interface cables must be used to comply with emission limits.

You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void your
authority to operate the equipment.

This device complies with Part |5 of the FCC rules. Operation is subject to the following two conditions: (1) This device shall

not cause harmful interference, and (2) This device must accept any interference received, including interference that may cause
undesired operation.

CE Certification

This equipment has been tested and found to comply with European EMC Emissions and Immunity regulations.
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iii. Software Licence Agreement

EMPEG LIMITED
END USER LICENSE AGREEMENT
FOR EMPLODE SOFTWARE

This Empeg Limited (“Empeg”) End User License Agreement accompanies the product and related explanatory materials

(“Software”). The term “Software” also shall include any upgrades, modified versions or updates of the Software licensed to
by Empeg. Please read this Agreement carefully. At the end, you will be asked to accept this agreement and contihag to ins
if you do not wish to accept this Agreement, to decline this agreement, in which case you will not be able to use the Software

Upon your acceptance of this Agreement, Empeg grants to you a nonexclusive license to use the Software, provided that you
agree to the following.

Use of Software.

You may install the Software on a hard disk or other storage device; install and use the Software on a file server for use on a
network for the purposes of (i) permanent installation onto hard disks or other storage devices or (i) use of the Software over a
network; and make backup copies of the Software.

You are not permitted to distribute copies of the Software to third parties.

Copyright and Trademark Rights. The Software is owned by Empeg and its suppliers, and its structure, organization and
code are the valuable trade secrets of Empeg and its suppliers. The Software also is protected by United Kingdom Copyright Law
and International Treaty provisions. This Agreement does not grant you any intellectual property rights in the Software.

Restrictions. You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to
discover the source code of the Software. The software is licensed by Empeg only for the purposes of interaction with Empeg
audio products.

No Warranty. The Software is being delivered to you AS IS and Empeg makes no warranty as to its use or performance.
EMPEG AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN
BY USING THE SOFTWARE OR DOCUMENTATION. EMPEG AND ITS SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR
IMPLIED, AS TO NONINFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR ANY
PARTICULAR PURPOSE. IN NO EVENT WILL EMPEG OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF
ANY EMPEG REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY
ANY THIRD PARTY. Some states, countries or jurisdictions do not allow the exclusion or limitation or incidental, consequential
or special damages, or the exclusion of implied warranties or limitations on how long an implied warranty may last, so the above
limitations may not apply to you.

Governing Law and General Provisions. This Agreement will be governed by the laws England and Wales, excluding the
application of its conflicts of law rules. This Agreement will not be governed by the United Nations Convention on Contracts for
the International Sale of Goods, the application of which is expressly excluded. If any part of this Agreement is found void and
unenforceable, it will not affect the validity of the balance of the Agreement, which shall remain valid and enforceable according to
its terms. You agree that the Software will not be shipped, transferred or exported into any country or used in any manner
prohibited by the United Kingdom Laws or any other export laws, restrictions or regulations. This Agreement shall automatically
terminate upon failure by you to comply with its terms. This Agreement may only be modified in writing by an authorized officer
of Empeg.

Unpublished-rights reserved under the copyright laws of the United Kingdom.
Empeg Limited, Dinder House, Dinder, Near Wells, Somerset, BA5 3PB. UK.
Empeg is a trademark of Empeg Limited.

YOUR ACCEPTANCE OF THE FOREGOING AGREEMENT WAS OR WILL BE INDICATED DURING INSTALLATION OF
THE EMPLODE SOFTWARE.
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1. Car Installation

The empeg-car unit is no harder to install than any other head unit: however, if you are not experienced with head unit installation
we recommend you leave the job to a professional. As with other two-part (i.e. head unit & separate amplifier) combination
systems, the sound quality — and in particular audio interference — is greatly affected by the way the units are wired.

A good car audio specialist will be able to supply and install a suitable amplifier unit as well as fitting the empeg-car.

Amplifier requirements

The unit has high-level line outputs, and requires an amplifier that can handle 3.2v RMS line outputs: ideally, you need to test the
empeg unit with the amplifier you intend to use before purchasing it. Ensure you get an amplifier with an adjustable gain control
so that it can be matched to the empeg’s output levels.

The unit provides four channels (two left/right pairs, one for front and one for rear), so for a four-speaker system you will require
either a four-channel amp or 2x two-channel amps. The empeg does not provide a separate subwoofer out - an external active
crossover is recommended for this.

When setting up the amplifier the gain should be turned to minimum (least sensitive) and then, with the empeg unit set to
maximum output (0dB attenuation), turned up until your maximum listening level is reached. Too high a sensitivity setting will
cause both distortion at high volumes and interference at low levels.

NOTE: The empeg provides floating ground outputs in order that the audio not be affected by digital interference
from the high-speed digital circuitry in the unit. Most amplifiers also have floating ground inputs in order to prevent
ground loops between the head unit and the amp, which result in large amounts of audio interference. In order for
the empeg’s outputs to function correctly, the inputs to the amplifier should be grounded to the amplifier’s GND
terminal with the supplied adaptor leads. Failure to do this will result in interference problems.

The empeg has been tested with a variety of amplifiers; quality 4-channel amplifiers are made by many companies — here at
empeg we've used JVC digifine, Longmill, Caliber, etc without problems.

Mounting Orientation
The unit is designed to mount horizontally: ideally, the unit should be leaning back at an angle of 8 degrees (this is fairly common
practice in car dashboards) but angles from 0 degrees to 16 degrees tilt (the rear of the unit being lower than the front) are

acceptable.

The unit is not designed to be mounted vertically (front faces upwards) or on its side, as this compromises the effectiveness of the
shock mountings inside the unit.

Physical

The empeg car dock is a DIN-E sized unit: the aperture it fits into is the standard size of 7.2” (183mm) wide and 2” (50mm) high.
The unit is 6.8” (173mm) deep, including cables.

As with other DIN units, the unit is secured with push-out tabs that hold onto the dashboard. After completing the wiring of the

dock, it should be pushed into place and the appropriate tabs pushed out (i.e. so they protrude on the outside of the dock) in
order to hold the dock securely in place.
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Electrical - Summary of Connections

Power

Black Ground

Red In-line 3A fused power input (+12 to + 16v)
Orange Amplifier remote power on

Antenna

Coax antenna socket
Audio

Line out (front pair/rear pair) 4 volt output: floating ground
Line in (pair) | volt input

Digital
Serial port (9-way female D type)
Electrical - Connection Details

Power input (RED)

The power input takes a maximum of |A at |2v to power the unit: any current taken by the amplifier remote line will increase
this value. The line is fused at 3A, and the empeg unit is internally fused at 3A. If the fuse blows, investigate and rectify the
problem (check the empeg unit powers up with the home power adapter) and always replace with a fuse of the same type and
rating.

An in-line power filter is supplied with the empeg, which filters out most ignition noise from the car supply: this should be
mounted where convenient. Due to the tightly packed circuitry inside the unit, there was unfortunately no room to fit an internal

filter.

The unit has a solid-state internal fuse. If this is tripped, disconnect the unit from the power supply and leave for a few minutes to
allow the fuse to reset, and check the unit works with the mains adapter before trying it again in the car.

The power input should be connected to the accessory line of the car wiring. The low current drain means that a separate battery
feed should not be necessary — if one is desired, then a SPNO relay can be used to allow the accessory line to control a direct
battery feed to the empeg unit.

Ground (BLACK)

The empeg unit works with negative earth cars only. The case is connected to ground, as is this connection.

Amplifier power on (ORANGE)

This line is used to turn the external amplifiers on. It should NOT be used to power the amplifier, as it is a low current line, which
can supply a maximum of | amp at |2v — this should be connected to the amplifier’s ‘Remote’ line, with the amplifier drawing its
power from a direct battery feed.

This line can also be used to control an automatic antenna, with the same proviso on current sourcing as above. Note that the
antenna will extend whenever the empeg is switched on, regardless of whether the tuner, digital audio or auxiliary source is
selected.

Antenna

This input is for the FM radio antenna. Note that the tuner is always powered in the empeg unit — even when the unit is in
standby mode (i.e. amplifier/display off).
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Audio

There are two pairs of audio outputs, with an output level of approximately 3.2v RMS. These are driven in a quasi-differential
fashion, and so the ground of the audio output is NOT the car earth: it is a ground sense from the amplifier ground to provide
better audio quality. You should take care to ensure that the ground of the audio outputs (i.e. the phono/RCA jack exterior) does
not touch the car bodywork: if they do, this will not damage anything, but it will result in reduced audio quality. In practice, this
usually means wrapping insulation tape around the audio connections after they have been connected to the in-car wiring.

You should ensure that the supplied audio grounding leads are used at the amplifier end to tie audio ground to amplifier ground,
allowing the floating ground outputs of the empeg to function correctly.

The line inputs have their own ground, which gives good quality audio input from both head units and portable CD/DAT/Minidisk
players.

Digital

The empeg serial port docks with the car-fitting cage, allowing connection to permanently fitted in-car computer equipment. The
connector provides transmit, receive, ground and + | 2v outputs.

IF THIS CONNECTOR IS NOT USED, CARE MUST BE TAKEN TO ENSURE THAT IT IS INSULATED DUE TO
THE 12v OUTPUT PRESENT ON PIN 4.
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2. Windows Software Installation

It is important to ensure that you do NOT connect the empeg player to your PC via USB before commencing the Windows
software installation. If you do so Windows will prompt you to supply a driver location — do not do so, but rather cancel the
dialog box, disconnect your player, and continue with the instructions that follow.

Insert the empeg car ‘emplode’ disk into your CD drive. The installation wizard
will automatically start, unless you have disabled auto-run in which case open the
CD and double click the Setup icon in the emplode folder.

The emplode Licence Agreement will be displayed please read this and click Yes
to indicate acceptance of the terms if agreeable to you. Release notes will then
be displayed, which should be read before clicking Next.

You will be prompted to enter your name, company (if applicable) and serial
number. The serial number can be located on the silver label attached to your
player. Please type the number exactly as it appears, including leading zeros,
then click Next.

If you wish to change the default installation folder you can now do so by clicking Browse, otherwise click Next to continue. You
can now specify the Start Menu location for the emplode icons, and click Next once more.

The software will now install onto your computer. Once complete, click Finish.

At this stage, it is recommended that you restart your computer.
Uninstalling the Windows Software
If you should wish to remove the empeg emplode software from your computer, open the Add/Remove Programs dialog from

the Control Panel. Scroll down the list of installed programs, select ‘empeg-car Management Software’ and click Add/Remove.
The software will now be totally removed from your computer.
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3. Home Installation

To download and organise music on your player you will need to connect it to your mains power outlet and PC. The power
adapter and cables that are required for this are supplied with the player. You may also wish to connect your player to your
home stereo to listen to your MP3 music out of the car — an additional cable is required for this purpose.

® ®lg TN

® ® Car Docking

Connector
1v Line Out llllllll
(Lo m @

RS232 Serial USB PowerIn

Figure 3.1 empeg car rear panel connections

Connecting to Mains Power

Connect the mains power cable to the power adapter, and then connect the power adapter to the empeg car player power
socket on the rear panel. As soon as the mains cable is plugged into a live socket the player will power up ready for use.

Note that the supplied power adapter is auto-ranging, suitable for use with voltages from 100v to 240v.

Connecting to your Home Computer
You can connect your empeg car player to your home computer with USB or RS232 Serial. USB is the recommended option for
downloading tracks, as it is much faster than RS232 Serial. You will need to use the Serial connection if your computer does not

have (or support) USB, and when upgrading the player software.

Cables for both USB and Serial are supplied. The Serial cable requires a 9-pin port — an adapter (not supplied) will be necessary
for connection to a 25-pin port.

To connect your player, simply insert the appropriate cable into the port on the rear panel of the player and into your computer-.
You should avoid connecting the USB cable until you have installed the supplied software (refer to Section 2).

Connecting to your Home Stereo

The RCA (phono) jacks on the rear of the player provide one volt line outputs suitable for direct connection to a home amplifier.
A cable for this purpose can be obtained from any electronics or hi-fi outlet (be sure to check the connections required by your
amplifier).

Note that the line outputs cannot drive any load directly — do NOT connect them to speakers or headphones.

For home use it is strongly recommended that you set the output gain (volume) on the player to 0dB and adjust the volume from
your amplifier. This will ensure optimum signal to noise ratio.
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4. The emplode Music Management Software

Before proceeding with this section, install the emplode software as described in Section 2.

Introduction

The emplode program is responsible for managing the music database on your empeg car player, including loading tracks, setting
and changing track details and organising your music. The program runs on your home computer and communicates with your
player via a USB or Serial connection — refer to Section 3 for details of making this connection.

Encoding Your Music

Before music can be played by the empeg car it must be encoded in MP3 (MPEG | Layer 3) format. This popular music format is
highly compressed yet maintains excellent audio characteristics, which is why you can store so much music on your empeg car.
The empeg emplode software does not perform the encoding — this may have been performed by your music vendor (if you are
purchasing tracks in MP3 format) or, if you wish to encode your own CD collection, a third party product is required. There are
many such products — some free, some commercial — available from the Internet and computer stores. We recommend Audio
Catalyst by Xing Technology (www.xingtech.com) as it is fast, of high quality and easy to use.

It is particularly convenient for your MP3 encoded tracks to have ID3 tags. This feature of many encoding programs incorporates

track titles, artist names and other details into the encoded track — often automatically via Internet music databases. If these
details are included at the time of encoding it will save you time later.

Starting the emplode Program

The empeg music database is stored on the car player itself, never on your PC, so before you can use emplode you must connect
your player to the computer (refer to Section 3) and switch it on.

Load the emplode program from the Start Menu (by default it will have been placed in a sub menu called ‘empeg car’). If the
player is connected and switched on a short interrogation sequence will take place during which the music database is retrieved.

If this does not happen check that the player is powered up and connected correctly. It may be necessary to tell emplode how

the player is connected — click Options to open the configuration window. If the player is ——
connected via USB select ‘Universal Serial Bus’. If it is connected by RS232 Serial select ‘Serial —— |
port’ and choose the port number from the drop down list. Click ‘OK’ when you have [ e
selected the appropriate connection. emplode will now attempt once again to connect to the ) il
L T ST
car player.
play! ¢ vl [ 1]
When the connection has been successfully made, and the music database retrieved, the
emplode main window will open. (=] o | |
E_EEI This emplode window shows a player loaded with music,
D [ e lmrke Dob G b= . . .
B F ASF LDPX =, ~EE T but the first time you run the program your player will be
Pt | P I almost empty.
G el pliged Ve Dt M L L s
sk LT v
Tom Note the format of the window — the menu and toolbar at
g 5
e the top, the playlist tree to the left and the music list to the
i )
;:_'- e rlght.
= P ¥
;T
o
o L
Mo e LT
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Playlist Tree

Tracks on the empeg car player are organised into playlists. A playlist is simply a collection of tracks that are grouped together,
perhaps because they have a common theme; they may be from a certain album, by a certain artist, or of a certain genre. A
playlist can contain further playlists (known as nested lists), and it is this hierarchy that provides for fast selection of music on the

player.

The top-level playlist, which is always present, is called ‘empeg-car’ by default and cannot be deleted. From thereon the structure
of your music database is entirely up to you. The way in which you choose to organise your music will reflect your personal
preferences.

In this example window you can see that tracks have been gf‘ bt e et ba B =L

& " AP LOPX L-ER Y

grouped into Artist, Group and Theme playlists. In fact, s | A onon
the tracks in each of the Theme playlists are copied from i || | [
an Artist or Group playlist. You can refer to a track in as o e i
many playlists as you want, but it will only be stored once F A=

L
|

in the player so no capacity is wasted.
When a playlist is selected on the car player, the tracks in g
any nested lists will also play, and so on until the entire
branch of the tree has played. For example, the top level
empeg-car playlist contains all of the tracks on the player,
whereas the Artist playlist shown opposite contains all of
the tracks for each of the Artists.

ol ]

B
= 05
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You may choose to organise your music in an entirely
different way to this — it’s up to you!

i

drenbable e WG ol 59 0

It’s easy to navigate the Playlist Tree: open a branch by clicking the + symbol, and close it again by clicking the — symbol.
Alternatively you can double click on a list to open or close it’s branch. To select a playlist, simply highlight it by clicking.

Track List

The track list displays each of the tracks and nested lists that are contained in the highlighted playlist. Four views are available:
Large Icons view, Small Icons view, List view and Details view. The view can be changed from the View menu, or from the
toolbar controls. In the List view (which is the recommended setting) click the headings to change the sort criteria.

Tracks are represented by this icon: ﬂ
Playlists are represented by this icon: Ega

To change the play order of a track within the list, click and drag it over the track that it is to precede. To delete a track highlight
it and press the Delete key, or select Delete from the Edit menu. Tracks and playlists can also be Cut, Copied and Pasted in the
usual way, and a convenient pop-up menu is provided by right clicking over a track or playlist.

As well as dragging tracks and playlists within the current view, they can also be dragged onto other lists in the Playlist Tree. If
you drag and drop the item will be moved to the appropriate list — if you hold down the Ctrl key before dropping the item will be
copied instead.

Creating a New Playlist

Select the playlist in which you wish to create the new list, by clicking on it in the Playlist Tree — if you are starting with a blank
player this will be the top level ‘empeg-car’ playlist. From the Edit menu select New Playlist, or click on the New Playlist control
on the toolbar.

The Tune Properties window will open, in which you can specify the Title of the list. The other fields are entirely optional and
may be used in future versions of the player software for track retrieval. Type in
the title of the playlist and click OK.

The new playlist will have been created, and can be navigated as described above.
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Adding a Track to a Playlist

Open the playlist to which you wish to add a track and click anywhere in the Track e
List section of the window. From the Edit menu select New Tune or click on the == I'ﬂ_ : =1 2] & gl im =
New Tune control on the toolbar. The Open File window will appear, from which -

you can navigate your computer in the usual way. Locate and select the track that T

you wish to add to your player and click Open.

The Tune Properties window will open, and if ID3 tags are present in the track some == | [o=_]
of the fields will be automatically filled in for you. You should ensure that at least the =~ M= riedemns = B ey

Title and Artist fields are completed — the other fields will be useful for advanced
track retrieval in future versions of the player software.

The track will have been inserted into the playlist. You can change it’s position or
move it between lists as described previously.

Another way to add tracks is with Windows Explorer drag & drop or cut & paste.

Synchronising the Player

Whenever you add playlists and tracks, or change the music database in any other way, the changes are stored within emplode
but not yet reflected by your empeg car player. This allows you to work quickly; adding tracks, organising your music and so
forth; without lots of delays every time some data needs to be transferred to the player.

When you are finished updating, you must synchronise the player music database with the changes. From the File menu select
Synchronise or click the Synchronise control in the toolbar. The synchronisation process can take anything from several seconds
to several hours, depending upon how much new music you have added to the database and whether you are using USB or Serial.

The Synchronise window will keep you up to date with the progress of the operation.

DO NOT SWITCH OFF OR DISCONNECT THE PLAYER DURING SYNCHRONISATION

When synchronisation is complete the player will be ready for use with the updated music database.

emplode Menu Functions

File Menu Revert Changes
Synchronise

Exit

Edit Menu Cut

Copy Copy the selected track or playlist onto the clipboard
Paste Paste the track or playlist from the clipboard to the current playlist
Delete Delete the selected track or playlist
Select All Select all tracks and lists within the current playlist
New Tune Add a tune to the current playlist
New Virtual Tune  Reserved for future use
New Playlist Add a nested list to the current playlist
Properties Edit the properties of the selected track or playlist
View Menu Toolbar Switches the toolbar on and off
Status Bar Switches the status bar on and off
Split Changes the split between the Playlist Tree and the Track List
Large Icons Switch to Large lcons view
Small Icons Switch to Small Icons view
List Switch to List view
Details Switch to Details view

Arrange Icons
Line Up lcons
Refresh

Discard any changes made and revert to the car player version of the database

Update the car player with the changes made
Exit emplode — changes will be lost if you haven’t synchronised

Cut the selected track or playlist onto the clipboard

Reserved for future use
Reserved for future use
Refresh the emplode window

Page 13



Window Menu New Window Open a new view onto the music database

Cascade Cascade all open views

Tile Tile all open views

Arrange Arrange minimised views neatly
Tools Upgrade empeg-car Software Refer to section 5

Options Set the emplode preference

emplode Toolbar Functions

The emplode toolbar implements tool tips — if you’re not sure of the function of a control, hold the mouse pointer over it for a
couple of seconds.

]
=
=

| A kTP X iy
From left to right, the toolbar functions are:

Synchronise, Properties, New Tune, New Playlist, New Virtual Tune, Cut, Copy, Paste, Delete, Up Level, Large Icons, Small
Icons, List, Details, and About.
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5. Operating the empeg car Player

The empeg car player is fast and intuitive to operate, using either the front panel controls or the infra red remote.

Front Panel Controls

Figure 6.1 empeg car player front panel

The front panel has four function control buttons. Each button provides different functions depending upon what the player is
currently doing, and whether you press and release or press and hold.

The following table summarises the functionality of each button:

Player Top Top Bottom Bottom Left Left Right Right

Mode (short) (hold) (short) (hold) (short) (hold) (short) (hold)

MP3 Play / Standby Menu Previous Volume Next Volume
Pause Mode Track Down Track Up

Tuner Mute / Standby Menu Previous Volume Next Volume
Unmute Mode Preset Down Preset Up

Aux Mute / Standby Menu Volume Volume
Unmute Mode Down Up

Menu Back Back Select Select Previous Previous Next Next

(repeating) (repeating) | Item (repeating) | Item (repeating)

When the player is in standby mode, pressing a button will restore it to its previous mode of operation.
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Remote Control

The infra red remote control provides fast access to many of the player’s popular functions.
As for the front panel controls, the function of many of the buttons depends upon the mode
of the player at the time.

(# Menu Button

This button reveals or hides the menu.

@& @ Skip Left & Skip Right Buttons

In MP3 mode these buttons skip to the previous or next track respectively. In tuner mode

they skip to the previous or next preset, and in menu mode they move to the previous or
next item.

. . Rew & FF Buttons

In MP3 mode these buttons skip backward or forward within the current track. In tuner mode they adjust the frequency.

Figure 6.2 Remote Control

. Play/Pause Button

In MP3 mode this button switches between play and pause. In tuner and aux mode it operates the mute function.
i~ 'G- Volume Up & Down Buttons

In MP3, tuner and aux modes these buttons adjust the volume level.

@ DNPP Button

In MP3 mode this button changes to the next visualisation. In menu mode it selects the highlighted item.

. . .' Input Select Buttons

These buttons select tuner, aux and MP3 modes respectively.
@ co-MD Button

This button switches between track information displays.
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Menu Functions

All empeg car player functions can be accessed from the menu system. Open the main menu by pressing the bottom panel
button or the ‘star’ button on the remote control. Change the currently highlight menu function with the left and right buttons,
or by using the ‘track skip’ buttons on the remote; when the required function (or sub-menu) is highlighted, select it by pressing
the bottom button or the DNPP button on the remote.

al shurite [Fower OFF playiists o Switches the player into standby mode
: Power 0fF | Playlists volume Leu Selects a playlist of tracks
0ff Flagtists | Ualume| Loudness Ba Changes the volume setting

Walum«: -3.00dE

Use the left & right buttons (or volume buttons) to raise or lower the volume.
0dB is full volume, overdrive should be avoided unless the track was recorded below
peak levels.

sts Uolume |Loudness galance Fa Changes the loudness setting

Loudness: 0.0dE (ofFd
Use the left & right buttons to raise or lower the bass boost (0dB is flat)

ne Loudness Balance Fader Cham Changes the balance setting

Balance: cenkre
1
Use the left & right buttons to centre the audio between the left & right speakers

ness Balance Fader channel Info Changes the fader Setting

Fader: centre
1
Use the left & right buttons to centre the audio between the front & rear speakers
lance Fader Chanmel Informatior Changes the input channel

dio aquxillary BMPE] radio quxilla

Select between empeg, radio and auxiliary

channel InFog;nF-gatinn Mk lis Switches the track/station information on or off
armation |HEst Uisual previous Selects the next visualisation

t tizual | Previols Visual| shui Selects the previous visualisation

suious Uisual Sl'lnzll-l;“g l&| Fawr v F Switches shuffle (random play) mode on or off
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6. Upgrading the Player Software

The software in the empeg car player is fully upgradeable, via your PC connection. Upgrades will be posted regularly to our web
site at the following URL:

http://www2.empeg.com/upgrades/

To install a car player upgrade, first download it from the web site. Be sure to read the release notes! You will be able to choose
between the consumer and the developer image — unless you are developing software for the player you should choose the
consumer image, as this has performance benefits.

To upgrade the software the car player MUST be connected by RS232 Serial — the USB connection will be ignored. Ensure that
the appropriate COM port is specified in the emplode options (although you can switch back to USB after doing so if you wish).

Switch off your car player and run the empeg Upgrade Tool from the Start Menu or from the emplode Tools menu.

Click Browse and select the upgrade file that you have downloaded, then T
click Next. Read the release notes and click next again. When the software
says “Finding Unit” switch on your car player and the upgrade procedure
will begin.
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Upgrading takes a few minutes, during which you will be informed of the

progress. Your music database, radio presets and other user settings will

not be affected.

Thos s i ol b poommd 1 e ol P
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Once the upgrade process is complete, the player will reset and is ready for
immediate use.
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